SINAMICS G120
with CU240S PN (FW3.2)

Control via PROFINET

Application • July 2010
Warranty and Liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventuality. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly. These application examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these application examples and other Siemens publications - e.g. Catalogs - the contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract ("wesentliche Vertragspflichten"). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the expressed consent of Siemens Industry Sector.
# Table of Contents

Warranty and Liability ........................................................................................................ 3

1 Automation function ........................................................................................................ 5
  1.1 Description of the functionality .............................................................................. 5

2 Functionality of the function example .......................................................................... 6
  2.1.1 Task description ................................................................................................. 6
  2.1.2 Solution .............................................................................................................. 6
  2.2 Structure of the function example ......................................................................... 6

3 Components that are required ...................................................................................... 7
  3.1 Hardware components ............................................................................................. 7
  3.2 Software components ............................................................................................... 7

4 Configuration and wiring ............................................................................................. 8
  4.1 Overview of the hardware configuration ............................................................... 8
  4.2 Connecting-up the hardware components ................................................................. 9
  4.2.1 S7-300 control and CU240S PN ...................................................................... 9
  4.2.2 PM240 and motor ............................................................................................ 10
  4.3 Fault 395 (acceptance test / acknowledgement present) ...................................... 11
  4.4 Important hardware component settings ............................................................... 11
  4.4.1 SM374 simulation module ............................................................................. 11
  4.5 Overview of inputs and outputs ............................................................................. 12
  4.5.1 Simulation module SM374 ............................................................................. 12
  4.5.2 SINAMICS G120 ............................................................................................. 13

5 Download ....................................................................................................................... 14
  5.1 S7 program .............................................................................................................. 14
  5.2 Setting the SINAMICS G120 IP adresse and device name .................................. 15
  5.3 SINAMICS G120 configuration ............................................................................ 19
  5.4 Exiting the STARTER parameterizing software .................................................... 20

6 Key performance data of the SIMATIC CPU ............................................................... 21

7 Background information .............................................................................................. 22
  7.1 Settings in the hardware configuration ................................................................... 22
  7.1.1 Properties of the SINAMICS G120 ............................................................... 23
  7.2 Functions of the Step 7 program ........................................................................... 26
  7.2.1 Program overview ......................................................................................... 26
  7.2.2 DB1, Axis_DB ............................................................................................... 27
  7.2.3 FB10, Organization ....................................................................................... 28
  7.2.4 FC100, Control of SINAMICS G120 ............................................................ 28
  7.3 SINAMICS G120 parameterization .................................................................... 29
  7.3.1 SIMATIC Manager - inserting SINAMICS G120 ......................................... 29
  7.3.2 Calling the STARTER parameterization tool ............................................... 30
  7.3.3 STARTER - carrying out quick commissioning ......................................... 30
  7.3.4 STARTER - carrying out a motor identification routine ............................... 31
  7.3.5 STARTER - setting the Profinet communications ...................................... 32

8 Appendix ...................................................................................................................... 34
  8.1 Internet link data .................................................................................................... 34
  8.2 History ................................................................................................................... 34
1 Automation function

1.1 Description of the functionality

The SINAMICS G120 drive inverter is a modular inverter system with degree of protection IP20. It comprises the two function units Control Unit (CU) and Power Module (PM).

When using the Control Unit CU240S PN, you have the possibility to use the PROFINET IO interface. This interface can be used for data exchange between inverter and control and to run the drive with the control.
2 Functionality of the function example

2.1.1 Task description

The SINAMICS G120 is to be controlled from an S7-300 CPU via Profinet.

2.1.2 Solution

In this function example, the control of a SINAMICS G120 (control word and frequency setpoint) will be demonstrated using an S7-300 CPU and a specific program example.

This program example comprises an S7 program to control the SINAMICS G120 and the appropriate configuration in the SINAMICS G120.

2.2 Structure of the function example

- In Chapter 3 the required hard and software components for the function-examples are shown.
- The download and test of the program examples supplied are described in Chapters 4 to 5.
- Chapter 6 informs about the key performance date.
- In Chapter 7 more detailed information are delivered. These Steps are not necessary for the commissioning of the function-example and you don’t have to do these because they are already included in the S7-Program and accordingly the SINAMICS G120 Project. The given information should help you with the creation of your own projects.
3 Components that are required

An overview of the hardware and software components required for the function example is provided in the Chapter.

3.1 Hardware components

<table>
<thead>
<tr>
<th>Component</th>
<th>Type</th>
<th>Order No./ordering data</th>
<th>Qty</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>PS307 5A</td>
<td>6ES7307-1EA00-0AA0</td>
<td>1</td>
<td>SIEMENS</td>
</tr>
<tr>
<td>S7-CPU</td>
<td>CPU 315-2 PN / DP</td>
<td>6ES7315-2EH13-0AB0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Memory Card</td>
<td>MMC 512 KB</td>
<td>6ES7953-8LJ11-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>DI / DO simulation module</td>
<td>SM374</td>
<td>6ES7374-2XH01-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Profile rail</td>
<td>Profile rail</td>
<td>6ES7390-1AE80-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PROFINET RJ45 connector *</td>
<td>PROFINET connector</td>
<td>6GK1901-1BB10-2AA0</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>PROFINET cable</td>
<td>PROFINET cable</td>
<td>6XV1840-2AH10</td>
<td>5m</td>
<td></td>
</tr>
<tr>
<td>Drive</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SINAMICS G120 Control Unit</td>
<td>CU240S PN F (FW3.2)</td>
<td>6SL3244-0BA21-1FA0</td>
<td>1</td>
<td>SIEMENS</td>
</tr>
<tr>
<td>SINAMICS G120 Power Module</td>
<td>PM240</td>
<td>6SL3224-0BE21-5UA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Basic Operator Panel</td>
<td>BOP</td>
<td>6SL3255-0AA00-4BA1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Motor</td>
<td>Three-phase induction motor</td>
<td>1LA7060-4AB10</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Note

The functionality was tested with the specified hardware components. Similar components that are different from those listed above can be used. Please note that in such a case it may be necessary to change the code example (e.g. setting other addresses).

3.2 Software components

<table>
<thead>
<tr>
<th>Component</th>
<th>Version</th>
<th>Order No. / ordering data</th>
<th>Qty</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC STEP 7</td>
<td>V5.4 + SP5 + HF1</td>
<td>6ES7810-4CC08-0YA5</td>
<td>1</td>
<td>SIEMENS</td>
</tr>
<tr>
<td>STARTER</td>
<td>V4.1 + SP5 + HF1</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/26233208">Link</a></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>GSDML-File CU240S PN</td>
<td>V3.2</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/26641490">Link</a></td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
4 Configuration and wiring

The hardware configuration and connecting-up the function example are described in this Chapter.

Please carefully observe the following safety information & instructions when using the SINAMICS G120:

![Warning]
The SINAMICS G120 has hazardous voltages and controls rotating mechanical parts that can also be potentially hazardous. If the warning information is not observed or the information & instructions from the instructions belonging to SINAMICS G120 are not complied with this could result in death, severe bodily injury or significant material damage.

4.1 Overview of the hardware configuration
4.2 Connecting-up the hardware components

4.2.1 S7-300 control and CU240S PN
4.2.2 PM240 and motor

For more detailed information regarding the installation please refer to the SINAMICS G120 Hardware Installation Manual Power Module PM240. Download from: http://support.automation.siemens.com/WW/view/en/22339653/133300
4.3 Fault 395 (acceptance test / acknowledgement present)

Fault F395 is output when powering-up for the first time and after replacing the Control Unit (CU) or the Power Module (PM).

This fault does not represent an incorrect drive inverter function. The reason for this fault message is to monitor the individual drive inverter components (CU and PM) to prevent them from being replaced by unauthorized personnel.

Acknowledging fault F395

Just like any other fault, it can be acknowledged using an appropriately parameterized input, via the field bus or using the STARTER parameterizing software.

4.4 Important hardware component settings

Most of the module/board settings are made in the HW Config in the software. Hardware settings are only required for the following modules/boards.

The modules/boards must be set with the control system in a no-voltage state.

4.4.1 SM374 simulation module

This module can be operated as 16 x DO (output via LED), 16 x DI (input via switch) or as combined 8 x DI / 8 x DO. The last combination is used in this function description.

The function of the module is selected using a rotary switch behind the front cover between the series of switches.

As shown in the following diagram set the function switches to the setting 8 x Output 8 x Input.
4.5 Overview of inputs and outputs

4.5.1 Simulation module SM374

<table>
<thead>
<tr>
<th>Address</th>
<th>Function</th>
<th>Symbolic address</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>O 0.0</td>
<td>Indicator lamp error</td>
<td>error</td>
<td>0</td>
<td>Faults are signaled via this output</td>
</tr>
<tr>
<td>1 0.0</td>
<td>SINAMICS G120 start</td>
<td>Start_G120</td>
<td>0</td>
<td>The motor connected to SINAMICS G120 is started by activating the input</td>
</tr>
<tr>
<td>1 0.1</td>
<td>SINAMICS G120 reverse</td>
<td>Reverse_G120</td>
<td>0</td>
<td>After the input is activated, a negative frequency setpoint is entered (direction of rotation reversal)</td>
</tr>
<tr>
<td>1 0.5</td>
<td>Increase frequency</td>
<td>Increase_frequency</td>
<td>0</td>
<td>The motor frequency can be increased using this input</td>
</tr>
<tr>
<td>1 0.6</td>
<td>Decrease frequency</td>
<td>Decrease_frequency</td>
<td>0</td>
<td>The motor frequency can be reduced using this input</td>
</tr>
<tr>
<td>1 0.7</td>
<td>Acknowledge error</td>
<td>ACK_error</td>
<td>0</td>
<td>Fault messages that are present can be acknowledged using this input</td>
</tr>
</tbody>
</table>
4.5.2 SINAMICS G120

The SINAMICS G120 is controlled and the feedback signals read-in via the I/O addresses listed below.

<table>
<thead>
<tr>
<th>Address</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>PQW256</td>
<td>Control word 1</td>
</tr>
<tr>
<td>PQW258</td>
<td>Frequency setpoint</td>
</tr>
<tr>
<td>PQW260</td>
<td>Torque setpoint</td>
</tr>
<tr>
<td>PQW262</td>
<td>Control word 2</td>
</tr>
<tr>
<td>PQW264</td>
<td>-- Reserve --</td>
</tr>
<tr>
<td>PQW266</td>
<td>-- Reserve --</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIW256</td>
<td>Status word 1</td>
</tr>
<tr>
<td>PIW258</td>
<td>Frequency actual value</td>
</tr>
<tr>
<td>PIW260</td>
<td>Current actual value</td>
</tr>
<tr>
<td>PIW262</td>
<td>Status word 2</td>
</tr>
<tr>
<td>PIW264</td>
<td>Last fault number</td>
</tr>
<tr>
<td>PIW266</td>
<td>Last alarm number</td>
</tr>
</tbody>
</table>

For more detailed information about the configuration of the individual signals, please refer to *SINAMICS G120 Operating Instructions Control Unit CU240S*, Chapter *Commissioning*.

5 Download

5.1 S7 program

To download the S7 program, you will require a connection between the MPI interface of your PG/PC and the MPI interface of the S7 CPU.

- Start the SIMATIC Manager.
- De-archive the function example supplied.
- Open the G120_STD_APP2 project.
- Select the MPI interface parameterization using Options > Select PG/PC interface….
- Open HW-Config and download this into the control. After the download re-close HW-Config.
- In SIMATIC Manager, select the block folder via CPU315-2 PN/DP > S7 Program > Blocks.
- Download all of the S7 program blocks into the CPU.
5.2 Setting the SINAMICS G120 IP address and device name

Different than for Profibus, for PROFINET, the node addresses are not set in the hardware, but in the software. To do this, a connection is required between the PG/PC and the PROFINET interface of the SINAMICS G120 via TCP/IP.

- To do this, connect the PROFINET cable from the SINAMICS G120, interface X01 P2 to the Ethernet interface (port) of your PG/PC (refer to Chapter 4.1).
- Set the IP address and the subnet mask of the Ethernet card of your PG/PC as follows.
• Using **Options > Set PG/PC Interface**..., select the TCP/IP interface parameterization. You can carry out all additional steps via this interface during the course of the function example.

![Set PG/PC Interface dialog box](image)

• Then, using **PLC > Edit Ethernet Node**..., open the dialog box **Edit Ethernet Node**.
• Press the *Browse...* button

![Edit Ethernet Node](image1)

• In the dialog box that then opens, select the node with the SINAMICS device type and then press the *OK* button.

![Browse Network](image2)
• (1.) Now, enter under **IP-address: 192.168.0.2** and under **Subnetmask: 255.255.255.0**. (2.) Then press the **Assign IP Configuration** button.

![Image](image_url)

• (3.) After completing the IP configuration assignment, enter the device name - assigned in HW Config - under **Device name:** (in this particular function example, **G120**). (4.) This is then assigned to the SINAMICS G120 by pressing the **Assign Name** button.

• Close the mask by pressing the **Close** button.
5.3 SINAMICS G120 configuration

When this has been completed, download the SINAMICS G120 configuration using the STARTER parameterizing tool.

- Starting from the main path of the SIMATIC Manager, start the STARTER parameterizing software by selecting the **SINAMICS_G120** icon and double click on the **Inbetriebnahme** icon.

- Then, in the Project Navigator of the STARTER parameterizing software select the object "**G120**" (1.) and press the button (2.) to establish the online connection to the drive inverter.

- After you have established the online connection, press the button to download the SINAMICS G120 drive parameters.

- Follow the instructions on the screen and acknowledge the prompt "**After loading, copy RAM to ROM**".
5.4 Exiting the STARTER parameterizing software

- If you don’t wish to set any additional parameters, then you can now exit the STARTER commissioning tool.
- In the tree select SINAMICS G120 and transfer all of the parameter changes into the ROM memory of the SINAMICS G120 by pressing the button.
- Then transfer all of the parameters into your offline a project by pressing the button.
- Disconnect the PG / PC from SINAMICS G120 by pressing the button.
- Now you can close STARTER using Project > Close or by pressing the button.
# Key performance data of the SIMATIC CPU

## Load memory and working memory

<table>
<thead>
<tr>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load memory</td>
<td>Approx. 6 k</td>
</tr>
<tr>
<td>Working memory</td>
<td>Approx. 2 k</td>
</tr>
</tbody>
</table>

## Cycle time

| Total cycle time (typical) | Approx. 1ms |
7 Background information

The individual functions of the example code are explained in the following Chapters so that you will then be in a position to implement your own project.

For this function example, the settings described no longer have to be made.

7.1 Settings in the hardware configuration
7.1.1 Properties of the SINAMICS G120

The window of the SINAMICS G120 PROFINET properties (2.) is displayed by clicking once on the SINAMICS G120 icon (1.).

The PROFINET telegram (2.) between the CPU and the SINAMICS G120 is the Standard Telegram, in this particular example, Standard Telegram 352 for the communications of the SINAMICS G120 (control signals, status signals, frequency setpoint, frequency actual value etc.)
The telegram is selected in the Catalog after pressing the button.

You can download the GSDML files for the SINAMICS G120 under the following link: [http://support.automation.siemens.com/WW/view/en/26641490](http://support.automation.siemens.com/WW/view/en/26641490)

GSD files are required to operate a node (e.g. the SINAMICS G120) on PROFINET – and to register (log-on) the device to the engineering tool.
Various pre-assigned telegrams are available for this communication; these can be selected from the hardware catalog (refer to 6.1.3).

The **Standard Telegram 352** is used in this function example. It contains a length of 6 words sending (output) and receiving (input) – beginning from starting address **256**.
7.2 Functions of the Step 7 program

7.2.1 Program overview

The Step 7 program essentially comprises blocks FB10, FC100 and DB1 that are called in the cyclic program (OB1).
7.2.2 **DB1, Axis_DB**

The Axis_DB represents the interface between the S7 program and the SINAMICS G120 via FC100.

Axis_DB is generated from **UDT 1 (Axis_DB_G120)**

Principal structure of Axis_DB:

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbolic name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBW0</td>
<td>Basic_Data.Moduleadress</td>
<td>INT</td>
<td>I/O start address of the SINAMICS G120 (refer to HW Config)</td>
</tr>
<tr>
<td>DBB3</td>
<td>Basic_Data.Drivetyp</td>
<td>Byte</td>
<td>Drive type, must be 2</td>
</tr>
</tbody>
</table>

**S7 -> SINAMICS G120**

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbolic name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBW4</td>
<td>Control_signals.STW2</td>
<td>Bool</td>
<td>Control word 2 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW6</td>
<td>Control_signals.STW1</td>
<td>Bool</td>
<td>Control word 1 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW8</td>
<td>Control_signals.Frequency_set</td>
<td>INT</td>
<td>Frequency setpoint in x.x %</td>
</tr>
<tr>
<td>DBW10</td>
<td>Control_signals.Torque_set</td>
<td>INT</td>
<td>Torque setpoint in x.x %</td>
</tr>
</tbody>
</table>

**SINAMICS G120 -> S7**

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbolic name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBW14</td>
<td>Status_signals.ZSW2</td>
<td>Bool</td>
<td>Status word 2 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW16</td>
<td>Status_signals.ZSW1</td>
<td>Bool</td>
<td>Status word 1 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW18</td>
<td>Status_signals.Actual_frequency</td>
<td>INT</td>
<td>Frequency actual value in x.x %</td>
</tr>
<tr>
<td>DBW20</td>
<td>Status_signals.Actual_current</td>
<td>INT</td>
<td>Current actual value (Value from SINAMICS G120)</td>
</tr>
<tr>
<td>DBW22</td>
<td>Status_signals.Actual_current_A</td>
<td>INT</td>
<td>Current actual value in x.xx A</td>
</tr>
</tbody>
</table>

**Error messages**

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbolic name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBW24</td>
<td>Faults.Drive_error_number</td>
<td>INT</td>
<td>Actual error number of the SINAMICS G120</td>
</tr>
<tr>
<td>DBW26</td>
<td>Faults.Drive_alarm_number</td>
<td>INT</td>
<td>Actual alarm number of the SINAMICS G120</td>
</tr>
</tbody>
</table>

In this function example the individual data of the DB1 are supplied in FB10.
7 Background information

7.2.3 FB10, Organization

This block is called-up in absolute terms in OB1 and in turn calls up FC100.

Principle of the FB10

<table>
<thead>
<tr>
<th>Network</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calls the FB11 to generate the frequency setpoint</td>
</tr>
<tr>
<td>2</td>
<td>Controls the SINAMICS G120 via the axis-DB, DB1. Calls the SINAMICS G120 control block FC100. Provides the feedback signals – incl. error and alarm number. This network can be used as template for additional SINAMICS G120 control functions.</td>
</tr>
<tr>
<td>3</td>
<td>Controls the signal lamp for fault.</td>
</tr>
</tbody>
</table>

7.2.4 FC100, Control of SINAMICS G120

SINAMICS G120 is controlled using the FC100 via PROFINET.

Only signals from the Axis_DB are used to control the block - but no fixed addresses - this is the reason that instances can be used.

This block can be used in the same way for both a standard and a Safety SINAMICS G120.

Formal operands of the FC100

<table>
<thead>
<tr>
<th>Formal operands</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nr_Axis_DB</td>
<td>IN</td>
<td>Number of the Axis-DB generated using UDT1</td>
</tr>
<tr>
<td>Internal_Error</td>
<td>OUT</td>
<td>Displays an internal error&lt;br&gt;0 = no error&lt;br&gt;1 = incorrect Axis-DB type (wrong UDT)</td>
</tr>
</tbody>
</table>

Principle structure of the FC100

<table>
<thead>
<tr>
<th>Network</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Opens the Axis_DB specified using the formal operands Nr_Axis_DB. Generates the internal error message.</td>
</tr>
<tr>
<td>2</td>
<td>Reads-in the SINAMICS G120 status words, processes these and saves them in the Axis_DB.</td>
</tr>
<tr>
<td>3</td>
<td>Resets internal error messages.</td>
</tr>
<tr>
<td>4</td>
<td>Converts frequency and torque setpoint from the Axis_DB (entered in x.x %) into the SINAMICS G120 format (hex).</td>
</tr>
<tr>
<td>5</td>
<td>Enters SINAMICS G120 error and alarm number into the Axis_DB.</td>
</tr>
<tr>
<td>6</td>
<td>Sends control words from the Axis_DB to the SINAMICS G120</td>
</tr>
</tbody>
</table>
7.3 SINAMICS G120 parameterization

7.3.1 SIMATIC Manager - inserting SINAMICS G120

- In SIMATIC Manager select the tree **G120_STD_App2** and using Insert > Program > SINAMICS select a SINAMICS G120 type object.

- Make the following settings and press the OK button.
7.3.2 Calling the STARTER parameterization tool

- Starting from the main path of the SIMATIC Manager, start the STARTER parameterization software by selecting **SINAMICS_G120** and double click on Inbetriebnahme.

- Then, in the Project Navigator of the STARTER parameterization software select the object **G120** and press button (2.) to establish an online connection to the drive inverter.

7.3.3 STARTER - carrying out quick commissioning

- The screen form with the actual configuration is opened by double clicking on Configuration in the Project Navigator.

- The quick commissioning Wizard is started after pressing the Wizard button.

- Enter the appropriate values into the Control structure to Encoder screen forms. You can call-up corresponding help texts in the individual screen forms by pressing on the Help button.

- In the screen form Drive functions, select for Motor identification, the function Ident. of all param. in standstill incl. the saturation curve (3).

- Enter the corresponding parameters into the Important parameters screen form.

- In the screen form Calculation of the motor data, select Restore factory setting and calculate motor data.

- In the screen form Summary do not activate the function RAM -> ROM, but instead press the Finish button.
7.3.4 STARTER - carrying out a motor identification routine

- After completing the quick commissioning, alarm **A0541** (Motor data-identification active) is displayed. Please carefully note that when starting the motor identification routine current flows in the motor. For hanging (suspended) axes the load must always be supported.

- To start the motor data identification routine, in the Project Navigator select the menu item **Commissioning** and activate by double clicking on **Control panel**.

```
After completing the quick commissioning, alarm A0541 (Motor data-identification active) is displayed. Please carefully note that when starting the motor identification routine current flows in the motor. For hanging (suspended) axes the load must always be supported.
```

- Press **Assume control priority** and carefully note the security/safety information and instructions. Then activate **Enables**.

```
Press Assume control priority and carefully note the security/safety information and instructions. Then activate Enables.
```

- **1.)** If the Control panel isn't completely displayed on your PG/PC, then press the **button.

- The motor data identification routine is started by pressing the **button. Do not exit the STARTER software and go to another task as otherwise the motor data identification routine will be interrupted for safety reasons.

```
1.) If the Control panel isn't completely displayed on your PG/PC, then press the button.
```

- Please wait until the **button changes back to the **button.

- Return the control priority to the S7 control by pressing the **button.
7.3.5 STARTER - setting the Profinet communications

- Communications between the CPU and the SINAMICS G120 must then be parameterized. To do this, open the screen for the communication settings using Communication -> Profinet. Select the tab Transmit direction.
- To start, select the Standard-Telegram 350 (350) from Message frame: (1.). This pre-assigns the telegram.

- Then replace telegram 350 by telegram type Free BICO connection (999) (1.). Deactivate any possibly active Suppress inactive interconnections function (2.) and establish the following interconnections (3.):
  - PZD 5 = r2131 (Last fault number code)
  - PZD 6 = r2132 (First warning number code)
Finally, you only have to save the SINAMICS G120 configured software in the ROM memory of the drive inverter. To do this in the Project Navigator select the menu item **SINAMICS_G120**

- In the function bar press the button.
- Please wait until the download operation has been completed.
8 Appendix

8.1 Internet link data

<table>
<thead>
<tr>
<th>Subject area</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to safety items</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/20810941">http://support.automation.siemens.com/WW/view/en/20810941</a></td>
</tr>
<tr>
<td>Siemens customer support homepage</td>
<td>Customer Support</td>
</tr>
<tr>
<td>SINAMICS G120 Homepage</td>
<td><a href="http://www.automation.siemens.com/mcms/standard-drives/en/low-voltage-inverter/sinamics-g120/Pages/sinamics-g120.aspx">http://www.automation.siemens.com/mcms/standard-drives/en/low-voltage-inverter/sinamics-g120/Pages/sinamics-g120.aspx</a></td>
</tr>
</tbody>
</table>

8.2 History

<table>
<thead>
<tr>
<th>Version</th>
<th>Datum</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>July 2010</td>
<td>First edition</td>
</tr>
</tbody>
</table>